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 Performance Tips and 
Tricks for ArcGIS 
Desktop 8.1 

 
Introduction This document provides a variety of recommendations and suggestions 

intended to help you leverage ArcGIS™ effectively.  The focus of the 
document is to suggest ways that you can optimize performance while 
performing various tasks using ArcGIS.  This information reflects the 
results of analysis conducted in response to working with many of our 
users on specific user scenarios and other information that was not 
available when the user documentation was printed.   

 
 

Other Suggested 
Resources 

Database Tuning Guides available with ArcSDE™ 
Online Help System 

 
Suggested Hardware 

Configuration for 
ArcGIS Desktop 8.1 

For best performance, use an appropriately configured PC. 
 
● Processor: Pentium® 450 MHz (minimum) or higher is recommended. 
 
● Memory: 128 MB RAM minimum (256 MB recommended). 
 
● Hard drive: Disk drives that deliver fast data access (e.g., SCSI, Ultra ATA, and so 

on) are highly recommended due to the nature of GIS data.  
 
● Windows® NT 4.0 SP 6a or Windows 2000. 
 
● Typically, you will want to set your paging file on your machine to be twice the 

amount of physical memory on your system. 
 
● If Windows Terminal Server is used, then a larger total amount of memory should be 

allocated.  This is especially dependent on the number of clients running off that 
server.  

 
● For display, a true color monitor and video card are recommended.  We recommend 

at least 16 MB of memory for the video card.  
 
● If you are using ArcGIS 3D Analyst™, you should invest in a good OpenGL™ 

video card with a minimum of 16 MB of memory.  Depending on what data you plan 
on using in the ArcScene™ application, you may also need at least 256 MB of 
physical memory on the machine and a video card supporting a large amount of 
texture memory. 
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● It has been reported that some antivirus software can significantly impact 
performance if it has been configured to scan all types of files on access.  You should 
consult your antivirus software manual for more information. 

 
● If the Microsoft® “Find Fast” process is running on your PC, we recommend turning 

it off.  This process periodically searches your file system and indexes the files for 
faster searching.  However, this may cause your system to appear to hang if you are 
using ArcGIS when the index process begins. 

 
Computers that plan on serving ArcSDE should be sized according to the database 
vendor’s specifications. 

 
ArcMap 

 
General Drawing 

Speed 
● Shapefile data sources will draw significantly faster if you use only a single symbol 

for display and have the map in the same projection as the data. 
 
● Shapefiles and coverages should have spatial indexes built for best performance.  

(This is done from the ArcCatalog™ property page of the dataset.) 
 
● Many users find that turning off the option to make newly added layers visible by 

default helps save time when initially composing a map.  To turn this option off, 
uncheck the box for this on the Options dialog box on the Application tab. 

 
● The mask functionality when symbolizing using Dot Density can be very slow on 

complex mask polygons.  You may want to consider only using this for the final 
hardcopy maps. 

 
● Using on-the-fly projection will increase the initial load time of a map document.  

Performance will always be better if you project all of your data into the same 
projection prior to displaying it in ArcMap™. 

 
Graphics and Text ● Halos on a large amount of text are slow to display; therefore, halos should be used 

sparingly.  Use a scale range on your label classification so not too many labels are 
displayed at once.  For many applications, text shadows provide the text background 
you need without the performance impact of using halos. 

 
● Dashed lines and patterned lines draw more slowly than solid lines.  You may want 

to consider only using these patterns for the final hardcopy maps. 
 
● The Advanced drawing options on the data frame will cause multiple redraws, 

increasng display time.  Use the advanced drawing only when printing or when 
zooming in to a small area. 
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Printing When printing with transparency or with rasters in the map, your plot file can be quite 
large.  From the Page Setup dialog box, you can control the output image quality and 
significantly reduce the plot file size.  Often, this will not have any significant impact on 
the resulting printed map’s overall quality, but it will reduce the time required to print the 
map as well as the size of the file that gets printed.  This is especially important when 
printing MrSID® images, as these images are uncompressed to the appropriate resolution 
prior to printing. 
 

Saving Maps If you are creating a complex map, you may want to turn off the “Create Thumbnail” 
option—found in the Map Properties dialog box.  Creating a thumbnail of your map (for 
viewing in ArcCatalog) will increase the time it takes to save the map document.  If it is 
taking a long time to save the document, and you have the thumbnail option on, simply 
press the Escape key; this will immediately terminate the thumbnail creation process but 
will not terminate the save process. 
 

Tables Use attribute indexes on fields.  Attribute queries use attribute indexes if the indexes are 
available; this will improve performance for such queries.. 
 

Tables, On-the-Fly 
Joins 

● Data from appended fields can be used to symbolize and label features and perform 
queries and many other operations.  Accessing the joined data will be slower than 
accessing data from the base table because of the additional work needed to maintain 
the join.  The following tips can be used when working with joined data to improve 
performance. 
�

� Create attribute indexes on the join fields.  Performance will be improved 
especially when editing, and in most cases, overall performance will improve.  If 
your joins involve only shapefiles, dBASE® files, coverages, or INFO™ files, 
indexing will not improve performance when drawing or working with the table 
window.  

 
�� When joining data from the same ArcSDE server or from the same personal 

geodatabase, you should click the Advanced button and choose “Keep only 
matching records”.  In some cases, this option will produce different results than 
you may want but allows the join to be processed by the database.  You will find 
that this is normally faster for operations that require accessing the data in the 
joined columns (i.e., symbolizing or labeling).  The default “Keep All Records” 
option always performs processing on the client.  Performance is normally good 
for operations that don’t require accessing joined data (i.e., drawing with default 
symbolization).  An operation may become much slower if accessing joined data 
is needed. 

 
� Cross database joins, where the target table and the join table are from different 

data sources, may have poorer performance.  This is especially the case where 
the join table is from an ArcSDE server, personal geodatabase, or an OLE DB 
connection.  Performance is much better when the join table is from a file-based 
data source (i.e., shapefiles, dBASE files, and coverages) and the target table has 
an ObjectID column (most data sources).  
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� Joining multiple tables or layers to a single layer can be costly in terms of 
performance.  If all of the data is from the same ArcSDE server and you chose 
“Keep only matching records” when joining, performance should not be greatly 
affected.  If “Keep All Records” is chosen, then the client, rather than the server, 
has to perform considerably more work, and performance will be impacted as a 
result. 

 
Dynamic 

Segmentation 
Indexes make dynamic segmentation display faster (especially geodatabases).  We 
recommend an attribute index for the route key field in both the route feature class and 
the event table.  We also recommend a spatial index for the route feature class. 
 

Utility Network Tools If you plan on doing traces from the Utility Network toolbar, it is recommended that you 
perform a “find connected trace” task first to cache the contents of the logical network in 
memory.  This will cut the time of future trace tasks in half. 
 

ArcCatalog 
 

Add Data Browser 
and ArcCatalog Tree 

● By default, the “Use a special icon for folders containing geographic data” option is 
turned off.  If you choose to turn this option on, it can significantly increase the 
startup and navigation time for ArcCatalog and the data browsers in ArcMap and 
ArcToolbox™. 

 
● Turning off data types you do not normally use can speed up ArcCatalog and the 

data browser.  To do this, choose “Options” from the Tools menu, and from the 
General tab, turn off the data types you don’t need to see. 

 
● By default, ArcCatalog only shows rasters based on file extensions.  ArcCatalog can 

discover rasters with other extensions if the option is turned on.  This option can 
have a negative impact on ArcCatalog and the data browser performance.  This 
option can be found in the Options dialog box from the Tools menu under the Raster 
tab. 

 
● To improve the navigation times for ArcCatalog and the data browser, you should 

uncheck the “Examine all extensions” option for DGN files in the Tools>Options 
dialog box under the CAD tab. 

 
● To improve the navigation times for ArcCatalog and the data browser, you should 

minimize the number of network folder connections.  Connect them only when you 
are using those network drives.  Also, do not connect to network folders at the root 
level.  Connect them directly to your desired network folder. 

 
● You can drag and drop a folder in ArcCatalog onto a catalog node in the treeview to 

make a quick folder connection.   
 
● To improve the navigation times for ArcCatalog and the data browser, you should 

avoid using extended column properties in Details view (such as file size, date, and 
metadata properties). 
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● When ArcCatalog opens, it returns to the last used location; this can be slow for 
network connections and locations containing a lot of data.  You can turn off the 
“Return to last location when ArcCatalog start up” option under the General tab in 
the Options dialog box. 

 
● When you are creating a layer file from a very large feature class, turn off the 

“Create Thumbnail” option.  If it is taking a very long time to create the layer file, 
simply press the Escape key.  This will immediately terminate the thumbnail creation 
process and will successfully create the layer file. 

 
Geometric Networks When creating a geometric network from existing feature classes, be sure to select the 

option to snap features if your features are not precisely located or have not previously 
participated in a network.  If a network was previously built from the features classes that 
have already been snapped, you should not have to specify snapping again. 
 

Raster Display Performance 
 

Creation of Pyramids The best way to improve the display speed of a large image is to build pyramids for it.  
Pyramids are multiscale resampled versions of the image that ArcGIS can create and 
manage.  Pyramids are useful when the raster dataset is larger in rows and columns than 
the screen canvas you are trying to “paint”.  Without pyramids, the entire dataset must be 
read from disk and resampled to a smaller size.  This is called display resampling and 
occurs on refresh of the ArcCatalog Preview pane or the ArcMap display canvas.  
Pyramids decrease the amount of time spent reading from disk and processing.  Taking 
the one-time cost to create pyramids will save time in the end.  You can build pyramids 
from the raster context menu in ArcCatalog.  The pyramid will be a file named 
imagename.rrd and will be 8 percent of the original uncompressed file size. 
 

Raster Compression Compression can improve performance by reducing the amount of time spent reading 
from disk.  However, since compressed data must be uncompressed to draw to the screen, 
it can be slower than uncompressed data.  The amount of time spent on decompression is 
often related to the compression ratio.  The more highly compressed the raster, the longer 
it will take to decompress. 
 

Calculation of 
Statistics 

When a raster without previously stored statistics is first introduced into ArcMap, and 
statistics are needed to render the raster correctly, ArcMap will create default statistics 
and place these into an associated auxiliary file (AUX).  If this occurs, then time is 
needed for the default statistics calculation.  Creating statistics for rasters in ArcCatalog 
prior to use in ArcMap is recommended. 
 

Display Resampling By default, ArcMap uses the fastest display resampling technique for all rasters, which is 
Nearest Neighbor resampling.  For continuous rasters, Bilinear Interpolation makes for a 
smoother-looking raster but takes a little more time.  This can be changed on the Display 
tab of the raster layer Property sheet. 
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ArcSDE Raster for 
Multiuser Access 

When many users are accessing the same raster files simultaneously, you will get better 
performance from a properly tuned relational database than from a file-based system.  
ArcGIS 8.1 supports the storing of raster data in a relational database using ArcSDE.  
After loading the data into ArcSDE, you should analyze the table for optimum 
performance. 

 
ArcGIS 

Geostatistical 
Analyst 

ArcGIS Geostatistical Analyst is optimized for small sampled datasets.  To process the 
data, the extension loads all the data and processes it in memory. 
 
To minimize the amount of data loaded, you should select a subset of points to use in 
your analysis. 
 

ArcGIS Spatial 
Analyst 

Make sure your analysis extent is set appropriately so you do not perform analysis on the 
whole dataset without fully intending to do so.  Use the extent properties in the Spatial 
Analyst Options dialog box to set the extent. 
 

ArcGIS 3D Analyst ● Turn off Saving a thumbnail with the scene document; this slows down the save 
process.  To do this, uncheck the option under File>Document Properties. 

 
● Using on-the-fly projection will increase the initial load time of a scene document.  

Performance will always be better if you take the time to project all of your data into 
the same projection prior to displaying in ArcScene (or ArcMap). 

 
● As with ArcMap, many users find that turning off the option to make newly added 

layers visible, by default, helps with initially composing a map or scene.  To turn off 
this option, uncheck the box for this on the Options dialog box on the Application 
tab. 

 
● When displaying images, you can boost the performance by draping them on a TIN 

rather than a raster. 
 
● 3D Analyst has to load all data sources into memory to render them in 3D.  This can 

use a lot of memory and affect the speed of opening a scene document.  To minimize 
the amount of data loaded, you can set a fixed extent of the scene that will only load 
data within the extent.  (Use the Extent tab on the Scene Properties dialog box to set 
this.) 

 
● For 3D navigation, consider using lower resolution data to display only while 

navigating, and then show the detailed data once navigation has stopped.  This can 
be set on the Rendering tab on the layer properties dialog box. 

 
● Raster data will be resampled while displayed in 3D.  You can set the raster 

resolution in the layer on the Base Heights tab of the layer properties.  ArcScene 
does a good job of dynamically setting these properties, but you may need to change 
the settings.  Very large images will always need some resampling unless you have 
very high-end video cards. 

 
● OpenGL cards with a large amount of texture memory (32 MB+) improve quality 

and performance when working with images. 
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● Many times display problems are corrected by downloading the latest video drivers 
from the video card manufacturers. 

 
ArcGIS StreetMap 

USA 
● Although you can use ArcGIS StreetMap™ USA data directly from the CD–ROM, 

for drawing and geocoding performance, it is recommended that you store the data 
on a hard disk.  To do this, create a new folder (e.g., d:\streetmap) and copy all the 
data from the CD–ROM to this directory.  It requires approximately 650 MB of disk 
space. 

 
● If you prefer not to copy all the data from the CD–ROM to the hard disk, you can 

copy only the files you need to use.  On the ESRI Data & Maps for StreetMap CD, 
you will find the compressed street data in the \data\streets folder.  The files are 
named in the format of <state abbreviation>.edg—for example, “ca.edg” for 
California streets.  If you know the addresses you are going to geocode are in the 
same state, you may copy the <state abbreviation>.edg to your hard disk.  Then you 
can create a new geocoding service for this .edg file.  Your geocoding performance 
will be improved.  

 
● To improve the drawing performance for streets in a particular state, you can copy 

the <state abbreviation>.edg and the StreetMap USA map document or layer file 
from the CD–ROM to the hard disk.  Then you can modify the layers data source 
property by resetting the data source to different locations, either on the hard disk or 
on the CD–ROM. 

 
Geodatabase The geodatabase contains many new concepts such as feature datasets, geometric 

networks, relationship classes, and so on.  How your data model is designed with respect 
to some of these will be critical to how well your geodatabase performs.  A poorly 
designed data model will affect the performance of the applications using it. 
 

Designing a 
Geodatabase 

● Group only the necessary feature classes into a single feature dataset (e.g., those that 
have topological relationships with each other). 

 
● When building a geometric network, choose only the necessary feature classes to 

participate in such a relationship.  
 
● When using relationships, be sure to maintain the indexes.  The performance is 

maximized when indexes are maintained for the primary and foreign keys for the 
relationship class.  ArcInfo™ and ArcEditor™ will automatically create these 
indexes for you, but be aware of their importance.  Indexes are very important for all 
relationship classes.  

 
● Load all the data you can before building your geometric network and before 

versioning your data.  
 
● Generate/Load all of your annotation before versioning your database.  
 
● In general, do as much data loading as possible before building networks and 

applying your UML model.  
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● If you do need to do a large amount of data loading or annotation creation after your 
have versioned your database, run Compress to get those new features from the 
“adds” tables to the base tables.  

 
Working with a 

Geodatabase 
● Always use the edit cache when editing geodatabase data. 
 
● Annotation performance is based on the actual number of annotation features that are 

displayed rather than the number of classes they persist in.  Make sure to apply scale 
suppression with annotation so you only see it when it is meaningful. 

 
● All related classes should be in the map when navigating relationships and editing 

composite objects.  
 
● When using a geodatabase, creating thumbnails for your large feature classes 

sometimes results in quicker browsing of the database in ArcCatalog.  
 
● Keep in mind that the shared edge editing tool works on all feature classes in a 

feature dataset regardless of whether they are layers in your map or not.  If you are 
using the shared editing tool, include all the classes from the feature dataset you are 
working with on your map. 
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